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Preface

Intended Audience
Welcome to Release 12 of the Oracle CADView-3D Studio User's Guide.

The purpose of this manual is to describe how to install and use CADView-3D Studio to
optimize and publish 3D models to CADView-3D Servers. End users with the 
CADView-3D DeskTop Web browser plug-in can stream these 3D models for viewing 
and collaborating over the Internet.

This manual is intended for users and managers who work with 3D models. Basic 
Windows computer system knowledge is assumed.

Important: The license cost of CADView-3D includes only Translators 
for the VRML v2 and STL open-source formats. Translators for other 
formats and CAD systems may be available through Oracle partners or 
third-party independent software vendors.

See Related Information Sources on page viii for more Oracle Applications product 
information. 

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
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technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be accessible to all
of our customers. For more information, visit the Oracle Accessibility Program Web site 
at http://www.oracle.com/accessibility/ . 

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise 
empty line; however, some screen readers may not always read a line of text that 
consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Structure
1  CADView-3D Studio Overview and Installation
2  Optimizing and Publishing Projects
3  Persistent IDs and DeskTop Behavior

Related Information Sources
This manual is intended to be used in conjunction with the other CADView-3D 
manuals. The following documents are also available for the CADView-3D product 
suite:

• Oracle CADView-3D DeskTop User Guide 

Describes how to install the CADView-3D DeskTop web browser plug-in and use it 
to navigate streaming 3D models and collaborate with other users in real-time.

• Oracle CADView-3D Translators User Guide 

Describes how to install CADView-3D Translators used to convert 3D models to 
CADView-3D format and optimize and publish 3D models via CADView-3D 
Studio to CADView-3D Servers.

Integration Repository
The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
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complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your 
instance is patched, the repository is automatically updated with content appropriate 
for the precise revisions of interfaces in your environment. 

Conventions

Convention Meaning

< > Angle brackets enclose user-defined data in 
filenames and paths as in
C:\<orant>\CADView-3D\Studio\

where is the name of the Oracle Home 
directory defined on your system. 

Boldface text Boldface type in text indicates emphasis on a 
particular word or phrase.

Boldface Text With Initial Caps Boldface type with initial capital letters 
indicates a menu item or text in title bar of 
user interface.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data unless 
otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your 
data and you lose the ability to audit changes to your data. 

Because Oracle Applications tables are interrelated, any change you make using an 
Oracle Applications form can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your tables 
get out of synchronization with each other, you risk retrieving erroneous information 
and you risk unpredictable results throughout Oracle Applications. 

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps track 
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of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
CADView-3D Studio Overview and 

Installation

This chapter covers the following topics:

• CADView-3D System Overview 

• Installing CADView-3D Studio 

• Installing CADView-3D DeskTop 

• Studio Overview 

CADView-3D System Overview 
The following is a general diagram of how a user accesses CADView-3D content 
published to a stand-alone CADView-3D Server. 
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Note: If you are using an Oracle E-Business Suite application, it is 
recommended that you use a CADView-3D Translator (along with 
CADView-3D Studio running in background) to publish your model to 
E-Business Suite. Refer to the CADView-3D Translator documentation 
included on the product CD.

The CADView-3D Server manages three types of data for a given 3D model: 

• Geometry data 

• Attribute data 

• Collaboration data 

Using a Web browser, the end-user clicks a link on an HTML page created by Studio. 
The HTML page contains a link to the CADView-3D Server on which the model is 
published. The CADView-3D DeskTop client is launched and receives geometry data 
and attribute data from the Oracle database associated with the CADView-3D Server. 
While viewing the model with DeskTop, users can send collaboration data to the 
database and receive collaboration data stored by other users. A group of users viewing
the model at the same time can perform realtime group meetings and create markups 
on a shared desktop. 

• See: Publishing Workflow 

• See: System Requirements 
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Publishing Workflow 
To publish a 3D model using the Studio interface, follow this process: 

Step Description Software Tools

1 Translate a native CAD model
to a .3DX file. Use the 
"Generate 3DX File Only" 
setting.

CADView-3D Translator for 
specific CAD application

2 Set up projects containing 
.3DX files (or .WRL and.STL 
files) and optimize the project.

CADView-3D Studio

3 (optional) Customize or 
"author" the way in which the
model is initially displayed.

CADView-3D DeskTop 
viewer launched from the 
Studio

4 Publish the output files for 
the 3D model to the 
respective servers.

CADView-3D Studio

System Requirements 
The minimum and optimal hardware and software configuration is shown below. 

Minimum System Requirements
• CPU: Pentium class 450MHz or equivalent

• RAM: 512Mb

• Hard Disk: ATA, SATA, SCSI or equivalent

• Operating System: Windows 2000 / XP / 2003 Server

• Network Card: 10 / 100 MIP

• Modem: N/A

• Video Card: N/A
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Optimum System Requirements
• CPU: Multi-Pentium Class 3GHz or equivalent+

• RAM: 1Gb+

• Hard Disk: ATA, Ultra2 SCSI+ or equivalent

• Operating System: Windows 2000 / XP / 2003 Server

• Network Card: 100/GigaBit MIP

• Modem: N/A

• Video Card: N/A

Installing CADView-3D Studio 

To install the CADView-3D Studio: 
1. Double-click the setup.exe file to launch the Oracle installer. 

2. In the Welcome screen click Next to continue. 

3. Choose a default installation path. The installer defaults to the Oracle home 
directory found on your system. Click Next to continue. 

4. In the Available Products screen choose the appropriate CADView-3D Translator 
and click Next to continue. 

5. Review the Summary screen and click Install to continue. 

The progress bar advances as the Translator and Studio are installed by default to 
the following destination folders: 
\<Orant>\CADView-3D\Translators\<name of translator>

\<Orant>\CADView-3D\Studio\

where <Orant> is the Oracle home directory found on your system. 

6. In the End of Installation screen click Exit to close the installation program. 

Note: You will also need to have CADView-3D Server software 
installed on the server system you are publishing to. Refer to the 
installation and configuration information in the readme.html file 
on your product CD.
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Installing CADView-3D DeskTop 
The CADView-3D DeskTop is used to view your model in a Web browser after 
publishing. It is provided in a separate Windows-based installer on your Oracle 

CADView-3D product CD. Alternatively, if you have been given "CADView-3D" 
responsibility in E-Business Suite, you can log in, choose "CADView-3D User" in 
Self-Service Apps, and navigate to the Install page to find a link to launch the installer. 

Once you install the CADView-3D DeskTop client on your system, when you open a 
CADView-3D model and connect to a CADView-3D Server, it will determine whether 
there is an upgrade available. If so, it will launch the installer automatically and prompt
you to install the upgrade. 

Note: Netscape users installing the DeskTop plug-in for the first time or
receiving an upgrade will need to click a "puzzle piece" in the Web 
browser to download the file to a local drive. They can then 
double-click this file to launch the installer for CADView-3D DeskTop.

In the Netscape version 7.0 Web browser, first disable the Netscape Plug-in Finder 
Service in order to download the CADView-3D DeskTop plug-in installer. Select Edit/ 
Preferences/ Navigator/ Helper Applications and uncheck "Always use the Netscape 
Plug-in Finder Service (PFS) to get plug-ins." 

To install CADView-3D DeskTop: 
1. Navigate to the folder in which the "CADView-3DDesktopSetup.exe" file is stored 

and double-click it. 

Note: The DeskTop installer downloaded or launched from 
E-Business Suite is named "ddddstin.exe."

2. In the Welcome screen, click Next to continue. 

3. In the Destination Folder screen, accept the default directory or click Change to 
browse to a different location. Click Next to continue. 

4. In the Setup Type screen, accept Default Complete or choose Custom and click 
Next to choose a specific module to install. Click Next to continue. 

5. In the Ready to Install Program screen, click the Install button to begin installation 
or click Back to review or change settings. 

6. In the Installing CADView-3D DeskTop screen, the progress bar advances as 
DeskTop is installed by default to the destination folder.
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\Orant\CADView-3D\DeskTop\

where "Orant" is your Oracle Home directory.

7. In the Setup Completed screen, you can choose to view the "readme.txt" file and 
click Finish to exit setup. The readme.txt is stored in the installation directory. 

Studio Overview 
The CADView-3D Studio converts certain types of 3D model files (.3DX, .WRL, or .STL 
files) into a set of output files. These files are then published to the CADView-3D 
Server. The published model can then be streamed over a network or the Internet and 
viewed with the CADView-3D DeskTop viewer (a web browser plug-in and ActiveX 
control). 

Studio takes geometry and attribute data from a hierarchy of parts and assemblies 
exported from the native CAD model and stores it in the Oracle database associated 
with the CADView-3D Server. This data can be queried dynamically in DeskTop using 
Attribute window or Parts List window. 

Collaboration data is created by end users with various features in the CADView-3D 
DeskTop. This data is also stored in the Oracle database associated with the 
CADView-3D Server. 

• See: Publishing From Studio 

• See: Publishing From CADView-3D Translators via Studio 

• See: Files Created During Publishing Process 

Publishing From Studio 
Studio has traditionally been used "stand-alone" in which you create an .A3P project file
in the Studio interface and then add input files (e.g., .3DX, .WRL, .STL). Studio can run 
either stand-alone or as a background process while publishing from a CADView-3D 
Translator interface. 
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Each 3D project can contain a single input file or multiple related input files with the 
same global coordinates. One reason to use the stand-alone Studio interface is to create 
a single project with multiple input files in order to create a "multi-stream" model. This 
is not possible using CADView-3D Translators which only publish models from a single
input file. 

• See: Optimizing 3D Projects with Multiple Input Files 

• See also: Authoring Stream Transformations 

Note: To obtain 3DX input files for Studio, set the "Generate 3DX 
File Only" option in a CADView-3D Translator to save the 3DX file 
in the Translator's output directory without publishing it. 
Additionally, to retain the .A3P project file generated along with 
.3DX file and a log file, set the Keep Intermediate Files option in 
the Translator configuration setttings before you publish to a 
CADView-3D Server.
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Publishing From CADView-3D Translators via Studio 
Using CADView-3D translators, you can translate, optimize, and publish your models 
from the Translator interface or command line without creating projects in 
CADView-3D Studio. 

Instead, you set Studio options within the Translator. After translation, Studio is 
launched automatically and runs in the background to optimize and publish the model 
to the designated CADView-3D Server. During publishing, geometry data and attribute
data for the model are stored in the Oracle database associated with the CADView-3D 
Server.

Note: You do not need to specify a Web server when you use 
CADView-3D Translators to publish to the Oracle E-Business Suite. 
Instead, the custom HTML data for your model is stored in the Oracle 
database and is transferred on the fly to the Web server when a user 
launches the model from a URL link in the Oracle application. Refer to 
the CADView-3D Translator documentation for more information.

Files Created During Publishing Process 
The following is an outline of the optimization-publishing process using stand-alone 
Studio with .3DX files. You can publish VRML 2.0 (.WRL) and stereolithography (.STL) 
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files directly from Studio without being translated into CADView-3D (.3DX) format. 

A single .EPF output archive file is created, in which the following files are packaged: 

• .AMM - meta file containing location of the CADView-3D Server 

• .3DI – geometry data 

• .EAD - attribute data 

The following files are stored outside of the .EPF file: 

• .MAP - map file used for persistent IDs 

• HTML file - points to AMM data that identifies the CADView-3D Server and the 
associated Oracle database. 

• The input files (.3DX, .WRL, .STL) remain in their respective locations. 

• The project file .A3P, workspace .VSW, .MAP, and .LOG project log file remain 
separate from the .EPF file in the project folder. 

Result of Setting the Auto-Publish Server
If you set the Auto-Publish to Server option in the Content Publishing tab, the output 
files and data will be published (copied) to the designated CADView-3D Server and the 
associated Oracle database. In addition:

• A custom HTML file is created and stored locally along with the output files and 
also copied to the designated Web Server. 

• A collaboration data record is created. If you are reoptimizing an existing model, 
any existing collaboration data is retained. 

• An attribute data record is created and populated with data extracted from the 
.EAD file. 

Instead, the former AM3 parameters are stored inside the cus­tom HTML file that 
Studio now creates. 

Inside the .A3P Project File 
The .A3P project is an ASCII text file created by Studio that contains settings and other 
information used to optimize a model and publishit to a CADView-3D Server. These 
settings correspond to the settings entered using the Studio interface roughly grouped 
under the following prefixes: 

• "Project." precedes general project information such as project name and Studio 
version number. 



1-10    Oracle CADView-3D Studio User's Guide

• "Project.Settings." precedes current optimization settings found in the 3D Project 
and Geometry tabs. 

• "Project.Publish.Settings." precedes current publishing settings found in the 
Content Publishing tab. 

• "Project.Publish.Status." precedes information about publishing status. 

• "Project.LastOptimization." precedes optimization settings used during the last 
optimization. 

• "file.0" precedes general input file information. 

• "file.0.Settings." precedes current optimization settings found in the Geometry tab 
for the input file where "0" increments for each input (.3dx, .wrl, .stl) file in the 
project. 

• "file.0.LastOptimization.Settings" precedes optimization settings found in the 
Geometry tab for the input file used during the last optimization. 

See also: Manually Editing the A3P Project File 

The following is an example of an A3P project file after optimizing and publishing a 
CADView-3D model: 

"Project.Publish.Status.State"="4"

"Project.Publish.Status.PackagedContentCRC"="-1104876072"

"Project.Publish.Status.PublishedContentCRC"="-1104876072"

"Project.Publish.Status.SettingCRC"="1883242353"

"Project.Publish.Status.PublishedMediaServer"="cadviewserver"

"Project.Publish.Status.PublishedMediaPath"="*default"

"Project.Publish.Settings.AutoPublish"="1"

"Project.Publish.Settings.ForceRepublishing"="0"

"Project.Publish.Settings.MediaServer"="cadviewserver"

"Project.Publish.Settings.MediaPath"="*default"

"Project.Publish.Settings.WebPath"="D:\\Program 

"Files\\Orant\\CADView-3D\\Web directory"

"Project.Publish.Settings.MediaServerUsePassword"="0"

"Project.Publish.Settings.HTMLEnable"="0"

"Project.Publish.Settings.HTMLTemplateIndex"="0"

"Project.Publish.Settings.CollabDBServerPath"="DSN=cadview"
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"Project.Publish.Settings.AttribDBServerPath"="DSN=cadview"

"Project.Version"="6.00"

"Project.Name"="081302"

"Project.GUID"="{F7FBA28D-E834-4EA7-A918-B7831DFCEB7E}"

"Project.WroteAM3File"="1"

"Project.Finished"="1"

"Project.Settings.CollabDBID"="0"

"Project.Settings.SpeedQuality"="0.5"

"Project.Settings.Incremental"="1"

"Project.Settings.Incremental"="1""Project.Settings.Keep3DX"="1"

"Project.Settings.CreaseAngle"="35.0"

"Project.Settings.ZAxisUp"="1"

"Project.Settings.QuantizeCoordinates"="1"

"Project.Settings.TriangleReduction"="99.0"

"Project.Settings.MaximumError"="10.0"

"Project.Settings.TesselationAccuracy"="1.0"

"Project.Settings.UseImportedSO"="0"

"Project.Settings.VrmlOneGroupForPasce"="1"

"Project.Settings.DiscardPoints"="0"

"Project.Settings.DiscardCurves"="0"

"Project.Settings.AssemblyStructure"="1"

"Project.Settings.CollabDBUseAccess"="1"

"Project.Settings.CollabDBName"="081302_CDB"

"Project.Settings.AttribDBUseAccess"="1"

"Project.Settings.AttribDBName"="081302_ADB"

"Project.LastOptimization.Settings.SpeedQuality"="0.5"

"Project.LastOptimization.Settings.Incremental"="1"

"Project.LastOptimization.Settings.Keep3DX"="1"

"Project.LastOptimization.Settings.CreaseAngle"="35.0"

"Project.LastOptimization.Settings.ZAxisUp"="1"

"Project.LastOptimization.Settings.QuantizeCoordinates"="1"

"Project.LastOptimization.Settings.TriangleReduction"="99.0"
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"Project.LastOptimization.Settings.MaximumError"="10.0"

"Project.LastOptimization.Settings.TesselationAccuracy"="1.0"

"Project.LastOptimization.Settings.UseImportedSO"="0"

"Project.LastOptimization.Settings.VrmlOneGroupForPasce"="1"

"Project.LastOptimization.Settings.DiscardPoints"="0"

"Project.LastOptimization.Settings.DiscardCurves"="0"

"Project.LastOptimization.Settings.AssemblyStructure"="1"

"Project.LastOptimization.Settings.CollabDBUseAccess"="1"

"Project.LastOptimization.Settings.CollabDBName"="081302_CDB"

"Project.LastOptimization.Settings.AttribDBUseAccess"="1"

"Project.LastOptimization.Settings.AttribDBName"="081302_ADB"

"Project.file.count"="1"

"Project.file.0"="file.0"

"file.0.FileName"="D:\\Program 

"Files\\Orant\\CADView-3D\\Studio\\InputFiles\\3DX\\stream_1.3dx"

"file.0.Name"="stream_1"

"file.0.FileType"="0"

"file.0.LastModified"="01bcca31:b6495a00"

"file.0.Optimized"="1"

"file.0.PreviouslyEnabled"="1"

"file.0.Settings.Enabled"="1"

"file.0.Settings.CreaseAngle"="35.0"

"file.0.Settings.ZAxisUp"="0"

"file.0.Settings.QuantizeCoordinates"="1"

"file.0.Settings.TriangleReduction"="99.0"

"file.0.Settings.MaximumError"="10.0"

"file.0.Settings.AttribDBUseAccess"="1"

"file.0.Settings.AttribDBName"="stream_1_ADB"

"file.0.LastOptimization.Settings.CreaseAngle"="35.0"

"file.0.LastOptimization.Settings.ZAxisUp"="0"

"file.0.LastOptimization.Settings.QuantizeCoordinates"="1"

"file.0.LastOptimization.Settings.TriangleReduction"="99.0"



CADView-3D Studio Overview and Installation    1-13

"file.0.LastOptimization.Settings.MaximumError"="10.0"

"file.0.LastOptimization.Settings.AttribDBUseAccess"="1"

"file.0.LastOptimization.Settings.AttribDBName"="stream_1_ADB"

Manually Editing the A3P Project File 
If you want to publish a model from a Studio project to Oracle E-Business Suite or to a 
CADView-3D Server behind a firewall, you must manually edit the project file. 

Enter the URL to the HTTP Tunnelling servlet: 
"Project.Publish.Settings.HTTPProxy"="<http://servername/servl

et/httptunnelling?>"

And install and configure the CADView-3D HTTP Tunnelling software on a Web server
on the same side of the firewall as the CADView-3D Server. 

You can also enter the following setting to automatically launch CADView-3D DeskTop
in a Web browser with the model loaded immediately after publishing: 

"Project.LaunchDesktop"="1"

See also: Republishing a Model Without an Existing .A3P Project File 
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2
Optimizing and Publishing Projects

This chapter covers the following topics:

• Using CADView-3D Studio 

• Working with Projects in a Workspace 

• Opening an Existing Project

• Using the Wizard to Create a Project 

• Default Settings and Studio Preferences 

• 3D Project Settings 

• Defining Group Project Settings 

• Input File Settings 

• Geometry Settings 

• VRML Settings 

• Defining Group Input File Settings

• Optimizing and Publishing 3D Projects 

• Merged Optimization Procedure 

• Reoptimizing a Project with Multiple Input Files 

• Using the Command Line to Publish Models 

• CAD Publishing

• How to Publish Native CAD Models Using CAD Publishing

• Batch Processing All Projects in a Workspace 

• Viewing Optimized 3D Models 

• Viewing 3D Models on Local Drive 

• Features Not Available When Viewing Locally 

• Viewing Published 3D Models on Server 
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• Authoring Published 3D Models 

• Authoring Stream Transformations 

• Republishing Models 

• Republishing a Model Without an Existing .A3P Project File

Using CADView-3D Studio 
The following topics describe how to use Studio to optimize and publish CADView-3D 
models to the CADView-3D Server. 

• See: Creating a 3D Project 

• See: Opening an Existing Project 

• See: Using the Wizard to Create a Project 

• See also: Default Settings 

• See also: Project Settings

• See also: Input File Settings

• See: Optimizing and Publishing 3D Projects 

• See: Optimizing 3D Projects with Multiple Input Files

• See: Using the Command Line to Publish Models 

• See also: Viewing Optimized 3D Models

• See also: Authoring Published 3D Models

• See also: Setting Default DeskTop Behavior with Overrides 

Note: If you want use the stand-alone Studio interface to publish to a 
CADView-3D Server connected to the Oracle E-Business Suite, you will
need to manually edit the .A3P project file to add several parameters. 
Alternatively, you can publish a model first via the CADView-3D 
Translator interface with the "Keep Intermediate Files" option set and 
then open the resulting .A3P project in Studio if necessary. However, 
all parameters required to publish to E-Business Suite can now be 
created using CADView-3D Translators.
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To create a 3D project in Studio:
1. From the Start menu, choose Programs > CADView-3D > Studio. The CADView-3D 

Studio application opens. 

2. Choose New from the File menu or click the New button. The New dialog box 
appears. 

3. Accept the default "3D project" for type of project file . 

4. Enter a project name to be used for the .A3P project file and resulting CADView-3D 
model name. 

5. Enter a location in which to store the project folder and output files. By default, the 
output path defined in Preferences is the directory in which Studio is installed: 

\<Orant>\CADView-3D\Studio\Output\

where <Orant> is your Oracle home directory. 

6. Click OK. A new project folder is created in the designated location with the .A3P 
project file in it. The project appears below the workspace in the Studio tree 
hierarchy. 

Note: If you are publishing your model to E-Business Suite, be 
aware that Studio cannot currently detect whether a model of the 
same name has already been published there. If you create a project
name that creates a model name that is already published to the 
database, that model will be overwritten. The project name must be
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unique so it doesn't conflict with other published model names in 
your organization.

Note: When naming your .A3P project file, be aware that the 
resulting output files should not have spaces in the basenames. For 
example, "project_1" (with an underscore) is a valid base name but "
project 1" (with a space) is not valid. When an HTML file is opened 
by the CADView-3D DeskTop, the Netscape Web browser doesn't 
recognize the space and replaces it with "%20". 

• See: Working with Projects in a Workspace 

• See: Inserting Files in a Project 

• See: Inserting Files from Folder 

• See also: Project Settings

• See also: Input File Settings

• See also Saving Projects 
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Working with Projects in a Workspace 
A workspace can contain a single project or a group of related projects. 

You can use the drop-down menu to select a workspace and view all projects contained 
in that workspace or to select a specific project to focus on, thereby hiding the others 
from view in the tree hierarchy. 

To insert files in a project :
1. Select (highlight) a project in the workspace. 

Note: If you select the Workspace itself and insert a an input file, a 
new project of the same basename is created for it automatically. If 
you select multiple input files, the basename of the first file is used 
as the project name.

2. Click the Insert Files button or choose Insert Files from the Edit menu. 

3. In the Open dialog, browse to the input file, highlight it, and click Open. Hold the 
Shift key to select multiple files in the folder. The selected file(s) appear under the 
project in the hierarchy. 
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Note: You can choose several input files of the same type or a 
combination of file types (.3DX, .STL, VRML) to be optimized 
together. The way in which the Studio creates the output files, 
however, differs based on the Enable Incremental Optimization 
setting in the 3D Project tab (See Optimizing 3D Projects with 
Multiple Input Files).

Inserting Files from Folder 
For projects that will contain a large amount of input files, you can first store all 
input files to a single folder and then select that folder from the Edit menu in 
Studio. 

4. Select (highlight) a project in the workspace. 

5. Choose Edit/Insert Folder and use the Browse for Folder dialog to locate the folder 
containing your input files. 

6. Click OK. The files found in that folder appear under the Project in the hierarchy. 

Note: All valid input file types (.3DX, .WRL, .STL) for the selected 
project are added, and all other file types found in the folder are 
ignored. 
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To save projects:
1. You can highlight a project or entire workspace and choose Save from the File 

menu at any time during the session. 

2. Upon closing the Studio application, you are prompted to save projects in the 
workspace that have changed since the last save. 

The following five options are present in the dialog: 

• Yes - saves the named project

• Yes All - saves all projects in the workspace

• No - skips the named project and goes to next unsaved project

• No All - skips all projects and closes workspace without saving changes.

• Cancel -cancels the Save and returns to open workspace. 

If the Workspace itself is new (untitled) you are prompted to name it and browse to 
a location in which to save it. 

3. To open a project previously created using Studio, choose Open from the File menu 
and browse to the location of the 3D project (.A3P) file. By default, project files are 
located in a folder of the same project name in Studio's default output directory: 
\<Orant>\CADView-3D\Studio\Output\<project>\<project>.a3p

where <Orant> is your Oracle home directory. 

You can also click File/Recent Files and choose from a list of projects opened in 
Studio recently. 

If you are opening a project created by running the CADView-3D Translator which 
in turn calls Studio, by default both project and 3DX files are located in this 
directory: 
\<Orant>\CADView-3D\Translators\<Translator Name>\

where <Orant> is your Oracle home directory. 

Opening an Existing Project
To open a project previously created using Studio, choose Open from the File menu and
browse to the location of the 3D project (.A3P) file. By default, project files are located in
a folder of the same project name in Studio's default output directory: 
\<orant>\CADView-3D\Studio\Output\<project>.a3p

where <orant> is your Oracle home directory. You can also click File/Recent Files and 
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choose from a list of projects opened in Studio recently. Note: All valid input file types 
(.3DX, .WRL, .STL) for the selected project are added, and all other file types found in 
the folder are ignored.

If you are opening a project created by running the CADView-3D Translator which in 
turn calls Studio, by default both project and 3DX files are located in this directory:
\<orant>\CADView-3D\Translators\<Translator Name>\

where <orant>t is your Oracle home directory.

Converting Legacy Projects 
You can open an earlier version .A3P project file (e.g., version 6.2.1) in Studio; however, 
you will need to specify a new CADView-3D Server version in the Content Publishing 
tab. 

When you first republish a project, geometry and attribute data are stored in the new 
database schema of the Oracle database associated with the CADView-3D Server. 
Collaboration data is not retained and a new empty collaboration record is created. As a
result, a new model is created that doesn't overwrite the existing model. 

Alternatively, if you want to migrate existing 6.2.1 models containing collaboration data
to the new database schema, use the CADView-3D Migration Tool provided on the 
product CD. Once the data is migrated, you can open the corresponding .A3P project 
file and republish the model as needed to the new server location. 

Using the Wizard to Create a Project 
The Wizard opens automatically when you open Studio. If you want to disable it, check 
both "No" and "Do Not Open Wizard Again" and close the dialog. If you want to reset it
to open when you open Studio, do so in Studio Preferences. 

To use the Wizard to create a project:
1. Choose Wizard from the Edit menu or click the Wizard button on the toolbar. The 

CADView-3D Studio Wizard dialog appears. Click Next to continue. 
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2. In the Input Files screen, click either Insert Files or Insert Folder and browse to a 
location in which to select input files. 
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If you want to insert multiple input files residing in different fold­ers to a single 
project, repeat steps 2 and 3 to add multiple files individu­ally. 

3. If you chose Insert Files, select a single file or shift-click to add multiple files from 
the same folder. If you chose Insert Folder, browse to the folder itself and press 
Enter. 

The specified files appear in the Input Files dialog. 

For a 3D project, you are allowed to insert more than one input file into a single 
project if you want to create either a merged or Multi-Stream model. See 
Optimizing 3D Projects with Multiple Input Files. 

4. Click Next to continue. 

5. Enter a name for your project or accept the default based on the name of the first 
input in the list. 

6. View the default settings in the Optimization screen. Click Edit to modify the 3D 
Project and Geometry settings, if desired. Click Next to continue. 
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7. In the Auto-Publish screen, choose Yes to enter settings to automatically publish 
after optimization or No to wait to enter publishing settings later. Click Next to 
continue. 
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8. If you choose Yes, review the Publishing settings and click Edit to modify them. 
Click Next to continue. 
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Note: You must enter a location for the CADView-3D Server before
exiting this step.

9. In the final screen you can choose to start the optimization, if desired. Click Finish 
to complete project setup, close the Wizard, and return to the Studio main screen. 
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Default Settings and Studio Preferences 
The Studio initially contains a group of factory-set options. These settings are stored in 
the Windows registry and can be viewed or changed by the user in Studio's Default 
Settings and Preferences dialogs. The current Default Settings and Preferences are 
copied to each new project when it is created. 

Default Settings are found in the following tabs: 

• 3D Project 

• Geometry 

• VRML 

• Content Publishing 

• See also: Editing Default Settings

• See also: Studio Prefereverts that tab's settings back to original factory settings 
stored in the Windows registry during Studio installation. 
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Note: If you change a default setting and want to copy it to an 
existing project, click the Default button in the corresponding tab in
project settings. 

Use the Edit/Preferences dialog to set the default output path in which all new projects 
are created. This location will appear in the File/New Project dialog when you first set 
up a project. You can edit the location there as well. However, once a project is created 
with the name and location you specify, it cannot be moved or renamed. 
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You can set the following Preferences: 

To enter or edit customized settings for selected project(s):
1. Select (highlight) the desired project in the hierarchy. 

2. Choose Edit/Project Settings or click the Edit Settings button to open the Project 
Settings dialog. 

3. In each tab, set the required options and click Apply. Refer to the option 
descriptions in the table that follows. 

4. Click OK to close the Project Settings dialog. 
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Note: In each settings tab, there is a "Default" button that copies 
over the current Default settings for that tab.

• See: 3D Project Settings 

• See: Content Publishing Settings

• See: Input File Settings 

• See also: Defining Group Project Settings 
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3D Project Settings 
In the 3D Project tab you can set the following options: 

Content Publishing Settings 
Use the Content Publishing tab to specify the location of the CADView-3D Server. You 
also use this screen to specify the path on the Web server on which the HTML file is 
stored. 

When publishing to the CADView-3D Server, all data is stored in the Oracle database 
by default. However, users have the option to store the geometry in a file system. 
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Attribute and collaboration data are stored by default in the in the Oracle database 
associated with the CADView-3D Server. 

Note: The default destination for geometry content is set as either 
"filesystem" or "database" in CADView-3D Server configuration.
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When a CAD source file is modified and retranslated and you republish your project, 
the HTML file is overwritten. The existing geometry and attribute data are overwritten 
with the most recent data from the CAD source model. However, any existing 
collaboration data will remain intact, such as annotations, views, paths, and URLs. 

Note: If you want to keep an existing model as-is and publish a new 
model based on the same CAD source file, create an .A3P project with a
new name and add the .3DX input file(s) to it. An additional model will
be published with a new name and an empty collaboration database. 
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Field Setting 
Auto-Publish If Auto-Publish is [off], when you optimize, the output files are written 
to the .EPF package file in the default output directory. Attribute data is written to the 
package file as well but is not written into a database and is not available when viewing
a model locally. The collaboration database is not created. 

See also: Features Not Available When Viewing Locally 

If Auto-Publish is set [to Server], after optimization, the output files are saved as usual 
in an .EPF package file in the project directory. During publishing, the data is unpacked 
and copied to the CADView-3D Server. 

Geometry content is stored in the filesystem by default. Attribute and collaboration data
are stored by default in the in the Oracle database associated with the CADView-3D 
Server. 

If this is the first time publishing, an empty record for collaboration data is created. If 
this is a subsequent publishing of the same project in the same location, the existing 
collaboration data is retained and a link to it is written in the HTML file for the model. 

Media Directory Accept the directory "*default" or browse to another media directory 
that has been previously set up on the CADView-3D Server. This directory is used to 
store the .3DI geometry file if the location for content is set to "filesystem" in 
CADView-3D Server configuration (default).

Note: You can rename and create additional media directories using the
CADView-3D Server Administrator tool logged in to the CADView-3D 
Server.

Note: See the "Readme.html" file on the Oracle product CD to learn 
how to configure settings for the CADView-3D Server. The setting 
"contentmedia" controls whether the geometry data is stored in the 
Oracle database (contentmedia=database) or as a 3DI file in the file 
system (contentmedia=filesystem). 

See also: Custom HTML File for the Model 

Custom HTML File for the Model 
CADView-3D Studio creates a custom HTML file and publishes it to the designated 
Web server. It now contains additional data for launching the model formerly contained
in a separate AM3 file. 

The following is an example HTML file (Cellphone4.html) published by Studio for the 
project "Cellphone4.A3P." The <EMBED> tag used by Netscape web browsers is 
contained within the <OBJECT> tag for Internet Explorer (ActiveX) web browsers. 
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<HTML>

<BODY MARGINWIDTH="1" MARGINHEIGHT="1" LEFTMARGIN="1" 

RIGHTMARGIN="0" TOPMARGIN="0" BOTTOMMARGIN="0" scroll="no">

<layer top="0" left="0" right="0" bottom="0" height="100% 

"width="100%">

<OBJECT ID="AM3DViewer 

"CLASSID="CLSID:69EC3DBD-771A-11D1-9FEA-00C04FC4F039"

WIDTH="100%" HEIGHT="100%">

<PARAM NAME="ModelName" VALUE="CellPhone4" >

<PARAM NAME="ModelDescription" 

VALUE="\\AP5384PC;D:\Oracle\Ora81\CADView-3D\Studio\Output\Cel

lPhone4\CellPhone4.a3p" >

<PARAM NAME="ModelGUID" 

VALUE="{80E27257-7CC1-4AC8-878A-14E96D3993A9}" >

<PARAM NAME="CollaborationDBAssID" VALUE="2540" >

<PARAM NAME="ThreeDURL"

VALUE="amt://ap5380pc/*default/cellphone4.amm" >

<PARAM NAME="ForceHTTP" VALUE="0">

<PARAM NAME="AutoEnable" VALUE="1">

<EMBED TYPE="media/x-am3" WIDTH="100%" HEIGHT="100%"

ThreeDURL="amt://ap5380pc/*default/cellphone4.amm"

ModelName="CellPhone4"

ModelDescription="\\AP5384PC;D:\Oracle\Ora81\CADView-3D\Studio

\Output\CellPhone4\CellPhone4.a3p"

ModelGUID="{80E27257-7CC1-4AC8-878A-14E96D3993A9}"

CollaborationDBAssID="2540"

ForceHTTP="0"
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AutoEnable="1">

</EMBED>

</OBJECT>

</LAYER>

</BODY>

</HTML>

Note: See also Setting Default DeskTop Behavior with Overrides to 
learn how to enter user-defined parameters to customize the way in 
which the DeskTop viewer initially displays the model. 

Defining Group Project Settings 
This feature allows you to enter specific settings in a single tabbed dialog box and have 
the changes applied to a group of selected projects. 

To define settings for a group of projects:
1. Control-click multiple to select projects in the tree hierarchy view. 

2. Choose Edit/Project Settings (Group) or click the Edit Settings button. The Project 
Settings dialog appears. 

3. Make the the desired changes in the tabbed dialogs. 

Note: Common settings appear in bold, and settings that differ 
between projects appear dim.

4. Click OK to save the changed settings to each project selected. 

Input File Settings 
When incremental optimization is set in the 3D Project settings tab, you must define 
different Geometry settings for each input file since each file is optimized 
independently for a Multi-Stream project. 

See also: Optimizing 3D Projects with Multiple Input Files 

To enter input file settings: 
1. Select (highlight) the input file in the hierarchy. 

2. Choose Edit/Input File Settings from the menu or click the Edit Settings button. The 
Input File Settings dialog appears. 



Optimizing and Publishing Projects    2-25

3. Make the desired changes in the Geometry (or VRML) tab. 

4. Click OK to save the changed settings to the selected input file. 

• See: Geometry Settings 

• See: VRML Settings

• See also: Defining Group Input File Settings

Geometry Settings 
The Geometry tab contains fields to set minimum level of detail and other values 
affecting the appearance of model. The DeskTop viewer will display each object with at 
least as much detail as specified. If a field is left blank, Studio ignores it when 
determining the model's minimum level of detail. 
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Option Description
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Crease Angle Sets the minimum external angle at which 
edges on the surface of an object are retained 
(default = 35). Some objects include surface 
discontinuities (such as creases, edges, 
corners) that need to be retained for rendering
and not smoothed. For example, if you set the 
Crease Angle to 30, all external angles lower 
than 30 degrees would be smoothed while all 
external angles equal to or greater than 30 
degrees would be rendered as discontinuities. 
If an object's edges are sharp in the original 
model but smoothed in the optimized model, 
lower the value for this option and reoptimize.
Conversely, if you notice that unnecessary 
edges or creases are created, raise the value 
and reoptimize the file.

Quantize Coordinates Quantizes object coordinates (truncates the 
single-precision floating point values) when it 
converts input model files. This results in 
faster performance with an accompanying 
minor degradation of display quality when 
the 3D model is viewed in the CADView-3D 
DeskTop viewer. Leave this option set unless 
you need to view very precise dimensions in 
the model you are converting.

Rotate +90 about X-axis Rotates your model +90 degrees about the X 
axis. Set this option if your model appears "on 
its side" when viewed in DeskTop. If you have
an STL (stereolithography) file exported from 
a CAD source with Z axis up (e.g. AutoCAD, 
CATIA, MicroStation, SDRC) you must set 
this option. 

Triangle Reduction % Sets the minimum number of triangles used to
render an object at its lowest level of detail by 
a percentage reduction. For example, with a 
setting of 90%, an object normally composed 
of 200 triangles would be converted to render 
with a minimum of 20 triangles.

Maximum Error % Sets a maximum percentage of error relative 
to a given object for its lowest level of detail. 
Default setting is 10%. A lower setting will 
result in a higher quality rendering.
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VRML Settings 
The VRML tab allows you to enter VRML settings on individual .WRL (VRML version 
2.0) input files when you set "incremental optimization" in 3D Project tab. 

Note: VRML 1.0 format is not supported. It is recommended that you 
export your model from the native CAD format directly to VRML 2.0. If
that is not possible, use a VRML 1.0 to VRML 2.0 conversion utility. 
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Option Description

Discard Points Set to discard any points present in the 3D 
model. By default, points are not discarded.

Discard Lines Set to discard any lines present in the 3D 
model. By default, lines are not discarded.

Defining Group Input File Settings
In a single tabbed dialog, you can enter Geometry (or VRML) settings for a selected 
group of input files from one or more projects. This feature is typically used if you want
to synchronize specific settings for a project with many input files. 

Note: When you turn off Enable Incremental Optimization in the 3D 
Project tab, input file settings are not available. Instead the Geometry 
and VRML tabs become available for editing at the Project level and 
will apply to all input files in the project. 

To define Geometry (or VRML) settings for a group of input files: 
1. Shift-click or Control-click multiple input files in the tree hierarchy. 

2. Choose Edit/Input File (Group) or click the Edit Settings button. The Input Settings 
dialog appears. 

3. Make the desired changes in the Geometry tab (and VRML tab if present). 

Note: Common settings appear bold and settings that differ 
between input files appear dim. 

4. Click OK to save the changed settings to each input file selected. 

Optimizing and Publishing 3D Projects 
Once you have created your project, added input files, and set the options, you are 
ready to run the optimization. You can also publish to a CADView-3D Server 
automatically after optimization. 

Note: The Studio requires approximately four times (4x) as much disk space as does the
set of input files it is optimizing. Additionally, the Studio requires two times (2x) the 
virtual memory size of all VRML files in the project. 
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• See: Optimizing 3D Projects 

• See: Publishing 3D Projects 

• See also: Files in Project Output Folder

• See also: Pausing and Resuming Optimization

• See also: Stopping and Skipping Optimization

Optimizing 3D Projects 
You can tell Studio to optimize all projects in a given workspace or select certain 
projects to optimize. 

• To tell Studio to optimize only certain projects in the Workspace, select (highlight) 
the project or control-click several projects. 

• Choose Go, Run Selected Projects or click the Run Selected button. 

• To tell Studio to optimize all projects in the Workspace, any of the projects can be 
highlighted. Choose Go/Run All Projects or click the Run All button. 

Studio begins processing each project in the workspace in alphabetical order. 
Percentage complete for the optimizing and publishing phases appear in the Progress 
Information tab for each project. The overall progress appears at the bottom of the 
window in the status bar. Information written to the log file is also displayed in the 
Output window above the status bar. 

Note: Studio detects when the input file's geometry has been changed 
and re-exported (using a timestamp) and when project or input file 
settings have changed. Only then will status become "Ready to 
Optimize"; otherwise, status is "Optimization Complete" and the 
message "no changes to optimize" appears in the output window. 

Publishing 3D Projects 
Publishing takes place automatically following optimization if you have set the 
"Auto-Publish to Server" option in the Content Publishing settings tab before clicking 
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the Run button. 

If Auto-Publish is [off] (default), all of the output files created during optimization are 
saved together in the project directory. 

If Auto-Publish is set [to Server], after optimization, the output files are saved as usual 
to the project directory, but are also published to the CADView-3D Server. 

Geometry content is stored in the filesystem by default. Attribute and collaboration data
are stored by default in the in the Oracle database associated with the CADView-3D 
Server. 

If this is the first time publishing, an empty record for collaboration data is created. If 
this is a subsequent publishing of the same project in the same location, the existing 
collaboration data is retained. 

• See: Files in Project Output Folder 

• See also: Package File (.EPF) 

• See also: Deleting Optimized Output Files 

Files in Project Output Folder 
When you optimize a project, a set of output files is created and stored in the project's 
folder in Studio's Output directory. To view the contents of the project folder use 
Windows Explorer. 

The following files remain outside the .EPF package file:

• The project file <project>.A3P is created when you create and save your project.

• The project log file <project>.log contains information and error messages created 
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during optimization.

• The <project>_<input file>.MAP file which is used to identify and maintain 
persistent object IDs across reoptimizations for CAD models that support persistent
IDs. 

Package File (.EPF) 
Starting in version 6, the set of optimized output files for each project are packaged in 
an .EPF package file after optimization prior to publishing. The following output files 
are included inside the package file: 

• <project>.AMM (contains CADView-3D server location) 

• <inputfile>.3DI (contains geometry data) 

• <inputfile>.EAD (contains attribute data) 

When you publish your project, this data is extracted and stored in the database 
associated with the CADView-3D Server. 

Deleting Optimized Output Files 
You can delete optimized output in the local project folder for selected project(s). 
Choose Delete Optimized Output Files in the Go menu. 

The .EPF package file for a selected project is deleted from the project directory. 

The project file (.A3P), workspace file (.VSW), .MAP file(s), log files (<project>.LOG and 
StudioLog.LOG), and any input files (.3DX, .WRL, .STL) for the project are not deleted 
and remain in their respective folders. 

Pausing and Resuming Optimization 
If the Studio encounters a problem in a file during optimization, it pauses and displays 
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an error message including the line number in the file where the error occurred. This 
information is also saved in the log file. You can choose to stop the process or continue 
optimizing, in which case the geometry node producing the error line is discarded. 

To manually pause a process, click the Pause button or choose Pause from the Go menu.

Choose the Run button or click Run from the Go menu to resume processing. 

Stopping and Skipping Optimization 
Choose Stop from the Go menu or click the Stop button to stop optimizing the 
workspace at the current project. The optimization for that project is halted at a 
checkpoint. In a subsequent session, the project will resume from the checkpoint and 
continue on until completed. 

To skip the current project being optimized and start the next project (alphabetically) in 
the workspace choose Skip from the Go menu or click the Skip button. The current 
project is checkpointed and the process is halted. The next project (alphabetically) in the
workspace will then begin optimizing. 

Optimizing 3D Projects with Multiple Input Files 
You can add multiple input model files to a single project. The input files can be any 
number of .3DX, .WRL, or .STL files. The Studio does not distinguish between .3DX files
from different CAD sources; however, when using multiple input files, all source files 
must use the same global coordinate system. 

The Studio can then use one of two methods to create the output files. 

Prior to version 5.0, multiple input files were merged into a single .3DI geometry file 
and single attribute database, and the output was rendered in DeskTop as a single 
integrated model. 

In version 5.0, the Multi-Stream feature was added. It became possible to independently
optimize several input model files in a project to create separate sets of output .3DI files 
and attribute data for each input model. The process is called "incremental 
optimization"; it is used to convert multiple input files into multiple sets of output files 
known as "streams" in the DeskTop viewer. 
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When optimized and published using incremental optimization, these models are 
stored on the same server and can be viewed from a single client. However, each model 
"stream" has its own attribute data and collaboration data as opposed to the merged or 
integrated model sharing data for all streams. 

Performance is enhanced in the Studio because input files that have not changed since 
the last optimization will be ignored (not be re-optimized) when the multi-file project is 
processed. This is useful when running a batch command at the command line. 
Additionally, optimization time is decreased because the intermediate "merged" state is 
bypassed. 

Performance is enhanced in the DeskTop viewer because the attribute and collaboration
data for each stream can be queried separately and the display of constituent parts can 
be turned on and off in the Structure window to decrease the rendering time. 

Merged Optimization Procedure 
Specifying incremental or merged optimization is done by setting or clearing the 
"Enable Incremental Optimization" option in the 3D Project settings tab. 

• See: Merged Optimization Procedure 

• See: Incremental Optimization Procedure 

• See: Reoptimizing a Project with Multiple Input Files 

To perform an optimized merge:
1. Using a CADView-3D Translator, convert desired CAD model files into 3DX 

format. Use the "Generate 3DX File Only" setting in the Translator. 

2. Move the 3DX output file from the Translator's output directory to a directory in 
Studio if desired. 

3. In Studio, create and name a new Project. 
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4. Using the Add button, add the individual .3DX files to the project. 

Note: You can also add .WRL and .STL files to the project, provided
all input files have the same global coordinates.

5. In the 3D Project settings, uncheck the Enable Incremental Optimization option. 

6. Start Optimization. A temporary merged .3DX file is made, and a single set of 
output .3DI (geometry) and .EAD (attribute) files are created using the same project 
base name. Only one .AMM file and one HTML file are created per project. 

When viewed in the CADView-3D DeskTop client, the individual input files will be
displayed as one integrated 3D model, and you will not be able to turn off streams 
as nodes in the Structure window. 

To perform incremental optimization
7. Using a CADView-3D Translator, convert desired CAD model files into 3DX 

format. Use the "Generate 3DX File Only" setting in the Translator. 

8. Move the 3DX output file from the Translator's output directory to a directory in 
Studio if desired. 

9. In Studio, create and name a new Project for the new integrated model. 

10. Using the Add button, add the individual .3DX files to be merged into the single 
integrated model. 

You can also add .WRL and .STL files to the project provided all input files have the
same global coordinate.

11. In the 3D Project settings, check the Enable Incremental Optimization option. 

12. Start Optimization. Individual sets of output .3DI (geometry) and .EAD (attribute) 
files are created for each input file using the input file's base name. Only one .AMM 
file and one HTML file are created per project. 

Individual model files for the project can be displayed independently in the 
CADView-3D DeskTop client by turning off other streams in the Structure window.
Attribute data and collaboration data for each constituent stream can be queried 
independently. 

Reoptimizing a Project with Multiple Input Files 
In a project with Enable Incremental Optimization set, only input files that have 
changed since their last optimization will be detected (using timestamp) and 
reoptimized. 
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For example, if you have your project workflow set up to export and optimize in batch 
mode at the end of the day, only files that changed in the CAD source will be optimized
after exporting. 

However, if you open a project in Studio and manually delete a .3DX file, for example, 
and add then it back to the project, the file will be re-optimized, even if the content was 
not changed. 

Using the Command Line to Publish Models 
You can optimize and publish models from the command line using the MS-DOS 
command prompt without opening Studio. You can use a text editor to create a batch 
(.bat) file containing the command and options you want to use and then execute the 
batch file at the command line. 

You will either need to enter settings in an existing .a3p project or specify Default 
settings and Preferences to set parameters to process input 3D model files (.3dx, .wrl, 
.stl). To publish to a CADView-3D server, set the Auto-Publish to Server option and 
enter server locations in the Content Publishing tab. 

Note: However, the recommended method to publish by command line
is to use the CADView-3D Translator version 11.5.9 or higher that calls 
Studio to do the publishing after translation is complete. There are now 
additional Studio-specific command line options available for the 
Translator command line. See the CADView-3D Translator 
documentation for more information.

The Studio command line has the following options: 

For all batch processes, log file information is appended to a global Studio log file 
(StudioLog.log) located by default in the "Output" directory. 

\<Orant>\CADView-3D\Studio\Output\StudioLog.log

Note: This location for global log file can be edited in Studio 
Preferences.

Additionally, project log files are still saved (overwritten by default) in the respective 
project folders. 

Note: If you are going to publish via Studio to a CADView-3D Server 
connected to the Oracle E-Business Suite, you will need to manually 
edit the .a3p project file to add several parameters. Alternatively, you 
can publish your model first via the CADView-3D Translator interface 
with the "Keep Intermediate Files" option set and then open the 
resulting .a3p project in Studio if necessary. 
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• See also: Batch Processing All Projects in a Workspace 

• See also: Batch Processing Selected Projects 

CAD Publishing
In the Design phase of product development, CAD models are used to not only 
represent the physical layout and appearance of a product, but are also used to define 
the product structure, items, and item attributes. CAD publishing enables you to 
publish item definition information from external CAD systems into the Oracle Item 
Master, through the CADView-3D Studio application.

Important: CADView-3D includes only translators for the VRML v2 
and STL open-source formats. Translators for other formats and CAD 
systems may be available through Oracle partners or third party 
independent software vendors.

Overview of the CAD Publishing Process
An overview of the publishing process is illustrated in the following diagram. 
Information from a native CAD system is imported into the Oracle Product Information
Management Data Librarian (PIM DL) Import Workbench. Using the CADView-3D 
Translator, item attributes, units of measure, and structure information are extracted 
from the native or external CAD model.

The Studio application then transfers the data to the PIM DL's Import Workbench. From
the Import Workbench, you can then map attributes, set up structures, and so on. After 
you map the data, it can be published into interface tables from which the data can be 
imported into the Item Master. 



2-38    Oracle CADView-3D Studio User's Guide

You can use the CAD publishing option to create a unified item definition system, 
which can help to reduce or eliminate multiple silos of information. CAD publishing 
also enables you to manage multiple structures, attributes, and processes associated 
with a product's configuration.

CAD publishing also eliminates manual data re-entry from system to system. This 
publishing process also provides a way for Engineering to more directly communicate 
product information within the product's lifecycle and with manufacturing.

CAD Publishing Implementation Considerations
Before setting up CAD Publishing , note the following implementation considerations:

• The name of the publish API is: Publish

• The signature is: CADBOMPublishAMImpl.publish

• The file definition includes one number and two srings: (Number SourceSystemID, 
String cadXML, String cadXSLT)

The following diagram illustrates the standard CAD publish process. After items, 
attributes, and structure information are extracted from the CAD system, they are 
mapped to the Oracle Item Master schema. A source system for each native CAD 
system also needs to be defined in PIM DL. Source system definition ensures that the 
extracted information will map correctly to the Oracle schema.

Note: The CAD publishing process should be implemented only by 
users who are familiar with both their native CAD system, as well as 
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the PIM DL and the Oracle Item Master schema.

Before using the API, you must do the following:

• Integrate with the Oracle E-Business Suite through customized code.

• Obtain an instance of CADBOMPublishAMImpl, and then call the Publish API 
from that instance, which accepts:

• The source system ID to which they want to publish the CAD data

• The cadXML that contains the import data

• The CadXSLT that converts the CAD XML into XML that can then be read by 
the Import Workbench.

How to Publish Native CAD Models Using CAD Publishing
Before you begin CAD publishing, make sure that the CADView-3D server is up and 
running. You can verify the server status by selecting the CADView-3D Server Status 
option under the Development Manager responsibility.

To Publish a Native CAD Model Using CAD Publishing:
1. Navigate to the Import Workbench.

2. In the PIM DL's Import Workbench , define the source system.
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Note: The source system specifies the native CAD system. From 
this system, CAD data will be imported into the Item Master.

3. Map attributes from the native CAD model to the Item Master.

4. Confirm that the CADView-3D server is running, and confirm the port and IP 
address of the CADView server.
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5. On the Schedule Requests: Request page, specify when you want the concurrent 
request to run.

6. On the Schedule Requests: Notifications page, select who should be notified when 
the concurrent request finishes.
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7. Submit the concurrent request.

8. After you submit the request, note the concurrent request ID. 

Note: You can view the details and status of your concurrent 
request, by selecting the Details icon in the Requests page.

To Set Up Project Settings in CADView-3D Studio:
1. After your concurrent request begins running, view the log details to retrieve the 

CADView-3D's server ID and port numbers. 
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2. Launch the CADView-3D Studio application.

3. Open an existing project or create a new one, and right click the project to navigate 
to the project settings.

4. In the Project Settings window, select the Content Publishing tab.
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5. Verify the following settings:

• Auto Publish option is set to Server

• Confirm that the CADView Server IP address matches and port number have 
been correctly identified.

6. In the EBS Source System field, click the button next to the Name field to bring up a 
list of the defined Source Systems.

7. Select the appropriate Source System that you previously defined.

8. Click the Apply button to save your selections.
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After you select the Source System and apply your selection, CADView-3D Studio 
extracts the metadata, where you can review it in the Import Workbench. From the 
Import Workbench, you can continue the process, by confirming the import results, 
before the data is imported into the Item Master.

Batch Processing All Projects in a Workspace 
Using the Studio dialog, create and save project (.a3p) files in a workspace (.vsw), 
specifying the necessary project settings. 

To optimize all projects contained in an existing workspace, change directory (cd) to the
Studio directory and enter the following at the command line, for example: 

Studio /b workspace.vsw

Note: It is only possible to process one workspace (.VSW) file per 
command line.
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Individual project log files are saved (overwritten by default) in each project folder. 
Collective log information is appended to a global Studio log file (StudioLog.log) 
located by default in the Studio "Output" directory. 

Batch Processing Selected Projects 
In the Studio window interface, create and save the project (.a3p) with input files and 
specify any necessary project settings (such as Auto-Publish and server locations). 

To optimize and publish specific projects, change directory (cd) to the Studio directory 
and enter a command such as the following: 

Studio.exe /b Project.a3p

or 

Studio.exe /b Project1.a3p; Project2.a3p; Project3.a3p

You can name up to six project files per command line. The projects need not all be in 
one workspace. Studio will optimize each project according to the settings you save in 
each project. 

Project log files will be created (overwritten by default) and saved in each project folder.
Collective log information is appended to a global Studio log file, StudioLog.log, 
located by default in the "Output" directory. 

Viewing Optimized 3D Models 
You can view your model after optimization using the CADView-3D DeskTop viewer 
(installed separately) launched from Studio. Similarly, you can view optimized models 
that have been published to a CADView-3D Server. When you view a published model,
you can see part attribute data, and you can customize or author features stored as 
collaboration data. Your authored features are available to other users when they first 
open the model. 

• See: Viewing 3D Models on Local Drive 

• See: Viewing Published 3D Models on Server 

• See: Authoring Published 3D Models 

Viewing 3D Models on Local Drive 
After you have optimized a project on your local drive, you can use the DeskTop viewer
to visually check the quality of the optimized model. By comparing it to the original 
CAD model, you can see if there are any differences in geometry, color, etc. You can 
then change conversion parameters and test your model locally before publishing to the
CADView-3D Server. 
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To view 3D models on a local drive:
1. Turn off the "Auto-Publish" setting in the Content Publishing tab in Project settings.

2. Choose Go/Run Selected Projects or click the Run button to optimize your model. 

3. Select (highlight) the project in the tree hierarchy. 

4. Choose View, 3D Model, From Local Disk or click the View From Local button. 

The output .EPF package file is unpacked on the local drive. The HTML file for the 
selected project is opened in the default web browser to display the 3D model. 

5. Compare the geometry of the optimized model rendered in the DeskTop viewer to 
the original model in its native format. Open the original file in the CAD or design 
application and compare the two rendered models side by side. 

Note: The attribute data and collaboration data are not available 
when viewing the model on your local machine. You need to 
publish to a CADView-3D Server and associated Oracle database 
for that. 

See also: Features Not Available When Viewing Locally 

Features Not Available When Viewing Locally 
When you use the CADView-3D DeskTop viewer to display a 3D model that has been 
optimized by Studio on a local drive but is not yet published to a CADView-3D Server, 
the collaboration and attribute database are not created. 

You can navigate and view the model, but you cannot see object attributes or use the 
following features: Animation tool, URL window, Meeting window, Attribute 
window, or Attachment window. You can, however, use the Markup window with 
dimensioning tools to make markups and save them as image files on your local drive. 
You can use the Viewpoint tool and Path tool to save .VIEW and .PATH files locally. 
And, since nothing is published to a CADView-3D Server, group meeting is not 
available. 

Note: You must publish to a CADView-3D Server with an Oracle 
database to view and attribute data and create collaboration data. 

Viewing Published 3D Models on Server 
After optimizing and publishing your project to a CADView-3D Server, you can use the
DeskTop viewer to view the model along with attribute data. You can also author 
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special features in the model stored as collaboration data. 

To view published 3D models on the server:
1. Select (highlight) the project in the tree hierarchy. 

2. Choose View/ 3D Model/ From Server or click the View From Server button. 

3. The HTML file for the published project is opened in the default Web browser 
displaying the 3D model. 

4. If you want to customize features found in DeskTop, see Authoring Published 3D 
Models. 

Authoring Published 3D Models 
Using CADView-3D DeskTop launched from the Studio application, you can customize
or "author" features in your model right after it is published. You may want to do this to
set up viewpoints, paths, URLs, or animations in advance for users without putting 
them in "MyViews" which would show up under your login name in DeskTop. 

You can only perform authoring after publishing is complete and only from an open 
project in CADView-3D Studio. Authored features are stored with the model's 
collaboration data and can be accessed by any user from an "Authored" node in the 
respective DeskTop window. 

For detailed information about creating Viewpoints, Paths, URLs, and Animations, refer
to the corresponding topics in CADView-3D DeskTop documentation. 

However, to create an "authored" viewpoint, you must first select the Authored node in 
the Viewpoint window. If you do not select the Authored node, the viewpoint will be 
created under My Views. (graphic: Cadv_st2_10)

See: Authoring Stream Transformations 

Authoring Stream Transformations 
You can use Studio to create Multi-Stream models in which multiple input files in a 
single project are optimized independently (see "Optimizing 3D Projects with Multiple 
Input Files"). 

At times it may be necessary to bring separate streams into registration to produce a 
"whole" model of constituent streams with a common center. The Author 
Transformation dialog enables you to make adjustments to each stream's position by 
applying transformations (translation, rotation, scale). Since a native CAD model may 
already have a transformation, all other transformations you apply are cumulative. 
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Note: Stream transformation can only be performed in Studio's 
DeskTop viewer from an open .A3P file of a published model. 
Therefore, only persons with access to the .A3P project file and Studio 
can author stream transformations. The dialog is otherwise not 
available in the CADView-3D DeskTop. 

To author stream transformations: 
1. Once the Multi-Stream model has been optimized and published, open the project 

.A3P file in Studio. 

2. Select (highlight) the project in the tree hierarchy. 

3. Choose View, 3D Model, From Server to open the published model in the DeskTop 
viewer. 

4. Right-click the viewing window and choose Author Transformations from the 
pop-up menu. 

Note: This menu item appears only when the DeskTop viewers is 
launced in this manner from Studio.

5. Select a stream in the Available Streams list.

Note: Stream transformation is typically used to bring multiple 
streams into registration, but you can also use it to reposition a 
model composed of a single stream.
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6. Click the Add button and select a type of transformation (Translate, Rotate, Scale, 
Center About Stream). 

7. In the dialog box enter value(s) to apply with the transformation. 

8. Click OK. The transformation/values appear in the list at right associated with the 
selected stream. 

Note: If you use Center About Stream, a pair of entries will appear 
such as Center (x, y, z) and Center (-x, y, -z). If you later want to 
remove the Center About Stream transformation you must remove 
both entries from the list. 

9. Select another stream and repeat the above steps. 

10. Click OK to save the transformations in the HTML file of the open project. 

11. Save and close your project in Studio. 

When the model is opened in the normal manner (outside Studio) by the 
CADView-3D DeskTop, the constituent model streams are found in their new 
positions. They cannot be "moved" by other users (except by using the Animation 
tool to animate parts). 

Note: If your model contains streams from CAD files with different 
file formats (e.g., inch/feet and m/mm), the resulting model will be 
measured in meters. 

Republishing Models 
When you modify your CAD source file and want to publish it again through 
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CADView-3D Studio, you can get one of two outcomes depending on whether or not 
you create a new project for it. 

When you republish your model over time from the same project: 

• Existing geometry data is overwritten with new data 

• Existing attribute data is overwritten with new data 

• Existing collaboration data is retained 

• The same model is accessed from the existing link and model name 

Use this method if you want to launch the model from the same link and have the 
model change dynamically over time as the CAD model changes. All of the 
collaboration data is cumulatively retained in one model. 

If you create a new project (with a new name) for a newly translated 3DX file and 
republish it: 

• New geometry data is created 

• New attribute data is created 

• Empty collaboration data record is created 

• A new version of the model is created with a new link and model name 

Use this default method if you want to keep a record of the model at various stages of 
development and begin collaborating with an empty collaboration database each time a 
new version is created. 

Note: If you are publishing your model to E-Business Suite, be aware 
that Studio cannot currently detect whether a model of the same name 
has already been published there. If you create a project name that in 
turn creates a model name that is already published to the database, 
that model will be overwritten. The project name must be unique so it 
does not conflict with other published model names in your 
organization.

See also: Republishing a Model Without an Existing .A3P Project File 

Republishing a Model Without an Existing .A3P Project File
If you published your model from a CADView-3D Translator, you must explicity set the
"Keep Intermediate Files" option to retain the 3DX and A3P files, otherwise, they are 
deleted after publishing. hese files can subsequently be used in Studio to publish 
merged or multi-stream models. 
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To republish a model from Studio for which there is no longer an .A3P 
project file:
1. Create a new project .A3P file in Studio giving it exactly the same project name or 

CADView-3D Model Name originating in the Translator. 

Note: Look for it in the Server/Model Information window in the 
published model in DeskTop or in the top node of the Structure 
window hierarchy. 

2. Add the existing 3DX file and any other necessary input files to the project. 

3. Set the required project settings to match those used in the Translator when the 
model was last published. 

Note: Make sure to set "Auto-Publish to Server" and "Force 
Republishing" in the Content Publishing tab.

4. Save the project A3P file and open it in a text editor such as Notepad. 

Edit the A3p file manually to add the following flag which tells Studio to ignore the 
GUID (global unique identifier) when republishing a model of the same name to 
that location. 

"Project.Publish.Settings.IgnoreGUID"="1" 

If you are publishing to E-Business Suite or to a CAD­View-3D Server behind a 
firewall, see: Manually Editing the A3P Project File. 

5. Open the project again in Studio and select Run Selected Projects from the Go menu
to republish your model. 
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3
Persistent IDs and DeskTop Behavior

This chapter covers the following topics:

• Understanding Persistent Object IDs 

• Setting Default DeskTop Behavior with Overrides 

• Creating a URL Template 

• Linking URLs to Parts Using Variables 

Understanding Persistent Object IDs 
CADView-3D contains several features that use persistent object IDs. In the DeskTop 
viewer, the Animation window and URL window expect persistent ID's to be in the 
published model. 

Some CAD source files, such as those originating in CATIA, do not support persistent 
object ID's in their native format. If the geometry in the source file is modified and 
re-exported and the project is reoptimized and published to the same location, users 
viewing the model in the DeskTop viewer may encounter unexpected behavior such as 
objects that switch places in animations. 

However, CADView-3D will detect a model that does not have persistent IDs and 
display a message when you first attempt to create something with an object ID 
relationship (in Animation window and URL window). You can continue, but you are 
made aware that your source model does not support this feature after reoptimization. 

If the model is reoptimized and a user attempts to play an animation or view a URL 
created prior to reoptimization, a message is displayed stating it is possible that an 
object may not be correct because the model has been reoptimized. 

The user can always relink the URL or reapply the animation to the correct object in the 
DeskTop viewer if necessary. 
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Setting Default DeskTop Behavior with Overrides 
You can specify default viewing behavior in the DeskTop by manually entering 
"override" parameters in the custom HTML file pointing to the model. These 
parameters then produce the corresponding settings in DeskTop. This allows you to 
customize the initial way the model appears when users initially open the model. 

Note: This optional feature is used only with the "stand-alone" 
CADView-3D product suite. You cannot use it if you are publishing to 
CADView-3D integrated with the Oracle E-Business Suite because the 
HTML data is stored in the Oracle database.

Since a new HTML file is created each time a model is published, you may want to wait 
until after your model is stable and no further reoptimization is required before you 
add the HTML overrides. 

In the HTML file created by Studio within the ActiveX <OBJECT> </OBJECT> tag, enter 
the override parameter in the following format: 

<PARAM NAME="wireframe" VALUE="1"> In the same HTML file , enter the same 
override parameter in the following format inside the Netscape <EMBED> </EMBED> 
tag: 

wireframe="1" 

The following parameters and values (not case-sensitive) can be set in HTML overrides:

Option Description

"viewname"="name" "pathname"="name" 
"viewpoint"="x y z r p r" (select only one of the
three). 

Sets either a view name, path name, or 
viewpoint to be active when the 3D model is 
opened Viewname is the name of a viewpoint 
stored in the collaboration database. 
Pathname is the name of a path stored in the 
collaboration database. Viewpoint is defined 
by a set of six numbers: position on the x, y, z 
axes along with heading, pitch, roll. For 
example: "5.0 5.0 -2.0 45.0 -10.0 0.0" 
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Option Description

"CreateUser"="username " Specifies a user name to be used in 
conjunction with the "viewname" and 
"pathname" settings to specify its owner to 
insure its uniqueness. Each user can create a 
number of uniquely named views or paths. 
However, identically named views or paths 
can exist in the collaboration database 
associated with a different users. If this setting
is omitted, the matching "viewname" or 
"pathname" from the current user viewing the 
model is loaded. If DeskTop is launched from 
Studio to perform authoring, then the 
matching "authored" view or path of that 
name is loaded. 

"fullscreen"= "1/0" 1 = the model is displayed in full-screen mode 
when opened, without the browser interface. 0
= the model is displayed with the browser 
interface (default). Note: Novice DeskTop 
users who initially view the model will need 
the browser interface displayed. 

"BackFaceCull"= "1/0" 1 = the model is displayed with Backface 
Culling on when opened (default). 0 = the 
model is displayed with Backface Culling off 
when opened. 

"Wireframe"= "1/0" 1 = the model is displayed with all objects in 
wireframe mode when opened. 0 = the model 
is displayed with all objects shaded when 
opened. 

"ShowTopView"= "1/0" 1 = a Top View window appears immediately 
when the model is opened. 0 = a Top View 
window is not displayed with the model 
(default). 

"showFrontView"= "1/0" 1 = a Front View window appears 
immediately when the model is opened. 0 = a 
Front View window is not displayed with the 
model (default). 
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Option Description

"speed"="number" Specify a specific speed value used for 
navigation between 0.001 (slowest) to 1000 
(fastest). 

"nearClip"="number" Displays the 3D model with a specific Near 
Clip Plane setting (value between .001 and 
5.0). Used with farClipMode setting. 

"farClip"="number" Displays the 3D model with a specific Far Clip
Plane setting (value between 0.1 and 15). Used
with farClipMode setting. 

"farClipMode"= "absolute" or "relative" Used in conjunction with "nearClip" or 
"farClip" setting. "If "absolute," the farClip 
value is interpreted as an absolute value, 
independent of the scene extents. If "relative," 
the farClip value is interpreted as a multiplier 
to the scene extents. 

"backgroundImage URL"="URL string" "Specifies the URL of an image to be used as 
the background texture. The dimensions of the
image must be powers of 2 and the image 
must have 24-bit color depth. Any one of the 
following types can be used: JPEG, TIFF, PCX,
TARGA or BMP. For example: 
"http://cadview/pattern.bmp" Once set, use 
"Graphics" Preference tab in DeskTop to 
show/hide image. 

"queryAttributeName"= "attribute" 
"queryAttributeValue"= "value" 

Specifies the attribute name and value with 
which to query the attribute database. If both 
are specified, the DeskTop client queries the 
database for the specified attribute and value 
and isolates the resulting objects. For example:
queryAttributeName = "color" 
queryAttributeValue = "red" 

"UserAlias"="UserName " Enters the login name of a given user in the 
"Meeting Alias" field in the General Preference
tab. After which, the field becomes grayed out
preventing further editing. 
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Option Description

"UserName"="UserAlias " Specifies a single name to be used for all 
DeskTop connections to the CADView-3D 
Server. This name overrides the DeskTop 
default which uses login name for each user. 
The "Meeting Alias" field in the General 
Preference tab becomes grayed out preventing
further editing. 

"AssemblyNode"= "/htmlfilename/stream 
name/node1/node2" 

Isolates the specified node(s) when DeskTop is
launched. The names in the path must match 
those shown in the Structure window. 

URLFrame="frame name" Specifies the name of the HTML frame into 
which URLs are launched for the URL 
Template feature. The HTML page must also 
have a frame defined with this name. If the 
frame is not found, the URL is launched in a 
separate window. See Creating a URL Frame 
for a URL Template. Note: Use this option to 
launch related documents and not related 
models. Other CADView-3D models should 
be launched by default in a separate browser 
window. 

URLTemplate= "URL string" Specifies the URL for a related document or 
model. It can also be used to tie object 
attribute values to URLs. The name of the 
attribute is specified inside HTML comment 
syntax. If a picked object has this attribute and
the user launches the URL, the value of the 
attribute is substituted in the URL before it is 
launched. See Creating a URL Template. 

See: Creating a URL Template, page 3-5

Creating a URL Template 
Using the "URLTemplate" override you can link a URL globally to a model or link a 
URL to a part in the model using one of the object's attributes. This feature allows you 
to do the latter without making an entry in the model's collaboration database. In 
essence it extracts one attribute of the part you pick and inserts it on the fly into a URL 
as it is launched by the DeskTop. The URL can be used to launch a related document or 
another CADView-3D model. 
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Note: You can also use the URLs window in CADView-3D DeskTop to 
link URLs to the model. Unlike URLs linked through HTML overrides, 
URLs added in the URLs window are stored with collaboration data 
and persist after the model is republished, assuming conditions in the 
model are met for persistent object IDs (see also Understanding 
Persistent Object IDs).

Like other HTML overrides, you need to manually enter a line in the HTML file after it 
is published to the Web server. To do so, use Notepad or another text editor. 

• See: Linking URLs to a Model 

• See: Creating an Alias for a URLTemplate 

• See: Creating a URL Frame for a URL Template 

• See: Linking Multiple URLs to a Model 

• See: Linking URLs to Parts Using Variables

• See: Linking URLs to Parts Using Variables with a PDMS System 

Linking URLs to a Model
You can associate URLs with the overall model so regardless of what you have selected 
you will have access to them. You may want to use this feature to link to the URL of a 
related model or to a specific HTML page or PDF document with information about the 
model. 

For example, if the following parameter is found in the HTML file, 

<PARAM NAME=

"URLTemplate"="http://www.oracle.com/cadview-3d/headset.html">

The URLs option in the pop-up menu will have the following sub-menu item displayed:

http://www.oracle.com/cadview-3d/headset.html

Then, when you launch the model and choose URLs in the View menu, you can choose 
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a URL under Model URLs to launch the URL in another web browser window. 

Creating an Alias for a URL Template
You can also define an "alias" or common name in the URL Template that will appear in
place of the URL in the sub-menu. 

Enter the alias as follows inside the quotes, just before the URL (no space): 

<PARAM NAME="URLTemplate"="<!--Related Model-->

http://www.oracle.com/cadview-3d/headset.html">

Linking Multiple URLs to a Model
Only one URL Template line is allowed in a given HTML file. Multiple URLs can be 
added, however, provided they are space separated and there are no line breaks 
(carriage returns). 

<PARAM NAME="URLTemplate"="<!--Related Model--> 
http://www.oracle.com/cadview-3d/headset.html(space) <!--Related Document
-->http://www.oracle.com/cadview-3d/headset.PDF" 

The URL aliases appear as separate items under URLs in the View menu. 

Note: If the URL contains a space interally, replace it with a 
non-breaking space entity (&nbsp).

Linking URLs to Parts Using Variables 
Two virtual attributes (AM_OBJECT_ID, AM_OBJECT_NAME) exist for each part in 
the model. They are available at run-time in the DeskTop client for all parts including 
those originating from VRML 2.0 and STL files. These attributes exist even when there 
is no attribute data from the source CAD model. However, you can choose any other 
attribute that was exported from the CAD source file as well. 

With the appropriate "URLTemplate" entry in the HTML file, when you pick a part in 
the model and then right-click it, the value of that attribute is substituted in the URL 
and an entry for it appears in the pop-up menu. 

You can also create a "frame" for it in the HTML page containing the HTML file link and
specify a "URLFrame" override in the HTML file (see Creating a URL Frame for a URL 
Template). 

If you have a collection of documents residing on the server that you have intentionally 
named according to corresponding parts in the model, you could create a URL 
Template that appends ".doc" or ".pdf" to the object name which is substituted as a 
variable: 

<PARAM
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NAME="URLTemplate"="http://www.oracle.com/cadview-3d/<!--AM_OBJECT_NAME
-->.doc"

The URLs launched might be, for example: 

• http://www.oracle.com/cadview-3d/bolt.prt.doc

• http://www.oracle.com/cadview-3d/cover.prt.doc

• http://www.oracle.com/cadview-3d/base.prt.doc

Then when you select a part and then right-click to open the pop-up menu, you can 
launch the URL containing the corresponding document. 

Linking URLs to Parts of Using Variables with a PDMS System
Alternatively, you could have an Active Server Page (ASP) web server application 
connected to a data warehouse or Product Data Management System (PDMS) 
containing model part data referenced by attribute. 

You could create a URL Template similar to the following with an alias and an attribute 
like "Component ID": 

<PARAM NAME="URLTemplate"="<!--Show

Component-->http://www.oracle.com/default.asp?value=<!--Component_ID-->"

A URL launched for a given part might be, for example: 

http://www.oracle.com/default.asp?value=11

When you pick a part in DeskTop (indicated in wireframe below) and choose URLs in 
the View menu, the part and the alias you have assigned appears in the sub-menu. 
When you select the item, the value for that attribute is passed to the corresponding 
variable in the ASP. 

The URL is then launched in a separate browser window displaying the related file 
from the PDMS. 

Creating a URL Frame for a URL Template
By default, when a URL is launched from the DeskTop through the URL Template 
mechanism, the new URL is launched in a new browser window. If you want to launch 
the URL in a frame connected to the DeskTop, enter a frame definition in the HTML 
page with the HTML link such as: 

<frameset rows="70%,30%">

<frame src="headset.html" noscroll noresize>

<frame name="frame">

</frameset>
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Also, enter a line in the HTML file with the same frame name: 

URLFrame="frame" 

The browser window for the example above would appear with the specified document
in a frame below the frame containing "headset.html" in the DeskTop browser window. 
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